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Compatibility Notes  
 
Wavecom Product Support Tool Software Release WPST 1.4 
 
 
 
Release availability 

• This release notes document  
• WPST 1.4 software release 
• The WPST Quick Start Guide 

 
 
Tool compatibility 

• CDMA Server 3.1.0.2 or later 
• Event Server 1.3.0.0 or later 

 
 
Module compatibility 

• Wismo Quik WQ24x8 hardware 
• WZ1.52X and later software 

 
 
System Requirements 

• Windows 2000 SP1 or later 
• Windows XP SP2 or later 
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1 Introduction 
The Wavecom Product Support Tool, WPST, is a Windows 2000/XP based application. 
WPST provides a means for manually configuring WISMOQ Q2438 module NVRAM 
parameters. These parameters establish the carrier specific operating characteristics of the 
module. WPST also provides functionality for updating the module operating software 
and carrier roaming lists.   
 
The WPST application includes the CDMA Server and Event Server applications which 
are used to communicate with the module using a computer COM port. The computer 
COM port must be connected to the WISMOQ Q2438 module serial ‘Data’ port using an 
appropriate serial interface cable.   
 
After WPST installation is complete, refer to the ‘WPST Quick Start Guide’ located in the 
C:\Program Files\Wavecom folder for information on using WPST. This document can 
also be accessed using the Windows Start button at: Start -> Programs -> Wavecom -> 
WPST Quick Start Guide. 
 

1.1 Software Installation 
Installation of WPST requires administrator privilege on the target computer system. The 
WPST software is provided as a Windows compatible “setup.exe” file. This file must be 
run on the computer to install the WPST application. Any previous version of the WPST 
application present on the target computer will be upgraded.  
 

1.2 Software Identification 
Once installed, WPST and CDMA Server software version information can be displayed 
as follows. 
 

1. Start the WPST program.  

2. Click the WPST Help->About WPST menu item. 
Version:  1.4.0.3 
Date:  January 26, 2006 8:41 pm 

3. In the Windows task bar, right click on the white Wavecom icon and select the 
‘About’ item from the popup menu. 

Version:  v3.1.0.2 

 4



© Copyright 2006, Wavecom Inc.  
 

 
 

1.3 Software Removal 
To remove the WPST application from the computer, use the ‘Add/Remove Programs’ 
item located in the Windows Control Panel.  
 
 

2 Special Notes or Restrictions 
This section identifies special notes or restrictions in this release. 

In WPST 1.4, the initial device selection screen is no longer presented to the user each 
time the program is started. Instead, the program will now default to the last used 
computer COM port. To select or change the COM port used by WPST, use the WPST 
menu item File -> Connect. Following a WPST installation, a COM port must be selected 
using this menu item. The WPST status bar will display the current COM port selection. 
 
Beginning with WPST 1.4, some security related user prompts of the program can be 
bypassed by the use of a HASP4 M1 USB security key. This feature is intended for 
Wavecom internal use. Overall program functionality is not effected by the presence or 
absence of the USB security key.  
 
The read only field ‘Directory Number PCS’ has been added to the NAM1 and NAM2 
sections of the WPST screen and reflects the value of the NV_DIR_NUMBER_PCS_I 
item. This field will always contain the same displayed value as the read/write ‘Directory 
Number’ field (NV_DIR_NUMBER_I) item. Each of these NV items is a different internal 
format for the same MDN value. 
 
In WPST 1.4, functionality to save the module PRL data to a file is provided. This 
functionality is used as follows: 
 

1. Select the PRL page in WPST. 
2. Select or enter the file name to save the PRL data to for the desired NAM(s). A 

new or existing file may be specified.  
3. Select the ‘Read -> Module’ menu item or click the ‘Read from Module’ tool bar 

icon to read the PRL data from the module and write it to the specified file(s). 
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2.1 NV Recovery 
The WPST Download function performs the following sequence of operations. 

1. Save current module NV data. 
2. Erase module memory. 
3. Download specified operating software. 
4. Restore saved module NV data. 

Beginning in WPST 1.4, functionality to automatically recover module NV settings in the 
event of a download failure (steps 2 through 4) is now implemented. During step 1 of the 
Download operation, the current module NV settings are saved to a backup file named 
<Module ESN>.nvb in the C:\Program Files\Wavecom\Server\backup folder. Upon 
successful completion of step 4 of the Download operation, the NV backup file is deleted.  
 
If the Download operation abnormally terminates, the module NV data in the backup file 
will be used in a subsequent Download attempt to the same module. Step 1 of the 
Download operation is not performed if a NV backup file with the modules ESN is 
present. In this case, the NV settings in the backup file will be used when restoring the NV 
items to the module (step 4). When the subsequent Download operation is successful, the 
NV backup file is deleted. 
 
The WPST main menu item ‘File -> Restore NV File…’ is also available for manually 
performing an NV restore operation. This menu item is available for use only when an 
operational load is present on the module. If a previous incomplete download operation 
resulted in the module being in boot block mode (WismoQuik reported in ‘File -> 
Connect’ screen), the ‘Restore NV File…’ item will be disabled. In this case, use the 
WPST Downloader to reload the module operating software and automatically recover the 
NV settings. 
 
When using the Restore NV File… menu item, the user is prompted to specify the folder 
and file name containing the NV data to be restored. Once specified, the backup file is 
read and the NV data it contains is written to the module. It is important to note that 
WPST makes no checks for suitability of the NV backup file data in the target module. 
NV data is module specific and care must be exercised when using the NV restore 
functionality. Specifying an incorrect NV backup file for the restore operation could result 
in a non-operational or marginally operational module.  
 
Note that if the specified NV backup file is located in the C:\Program Files\Wavecom\ 
Server\backup folder, the backup file will be deleted after successful restore of the module 
NV data. Deletion of the NV backup file occurs only for this directory path.  
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2.2 Special RUIM Software Note 
Recall that for RUIM software loads, the ESN specified by the RUIM card masks the 
module factory provisioned ESN. The automatic NV backup functionality of the WPST 
downloader works properly when updating an existing RUIM based software load to 
another RUIM based load. A NV backup file is created using the RUIM card specified 
ESN (card inserted) or ESN 00000000 (card not inserted) during step 1. As long as the 
card insertion state is not changed, the NV backup file will be properly accessed in step 4 
and the module calibration data will be properly restored. 
  
In the case of ‘RUIM to non-RUIM’ or ‘non-RUIM to RUIM’ download operation, an 
additional manual step is required to restore the module calibration data. This is necessary 
because the ‘old’ ESN value is used to create the NV backup file in step 1. Following step 
3, the ‘new’ ESN value is reported by the module. Since a NV backup file with this new 
ESN does not exist, WPST will report an error at step 4 and terminate the downloader. In 
this situation, it is necessary to use the WPST ‘Restore NV File…’ menu item to manually 
reload the NV backup file, named with the ‘old’ ESN value, into the module and restore 
the module calibration data.

 7



© Copyright 2006, Wavecom Inc.  
 

 
 
 

3 New Features and Changes 
This section identifies new features or operational changes in this release. 

Id Description 
1987 NV Item erase/restore logic 

During any download operation (download only, provisioning) all the NV items are 
erased by the application software. The tool used has to save all of them and then restore 
them at the end of the process. If the process is interrupted for any reason all or part of 
the items are lost. 

1683 WPST security protections 
For internal analysis purposes, it would be useful to have a WPST that allows reading the 
module content without asking for any security code. The audience for this open version 
of WPST would be Wavecom Inc customer return analysis only. 

 
 
 

4 Corrected Defects 
This section identifies the corrected defects in this release. 

4.1 WPST Corrections 
Id Description 

2044 Create PRL file popup 
After clicking a 'Browse' button on the PRL screen, a screen titled 'Open' is used to 
select/entry the PRL file name. If a PRL file name is entered that does not exist, another 
'Open' screen is presented asking for file creation confirmation. 

2043 Entry of invalid PRL file name 
If an invalid/non-existent file name is entered in either PRL box, no error is reported 
when a subsequent "Write Module" is performed. 

2042 Blank PRL screen 
On the WPST PRL screen, click mouse on either of the file name entry boxes. Press 
return and the screen will blank. Screen can be restored by selecting another view and 
then reselecting the PRL view. 

2041 NAM2 SID NID pairs field name 
The NAM2 'SID NID Pairs' field name contains two spaces prior to the word 'Pairs'; 
there should be just one space. Pairs is also capitalized; it should be lowercase as in 
NAM1. 

2011 WPST - Del key removes screen objects 
It is possible to remove screen objects in the "Settings" view using the Del key. 

1999 Repeated PRL and ERI writes may corrupt files 
If a PRL or ERI file is re-used (i.e. repeatedly read from and written to), the file may 
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Id Description 

become corrupt. 
1997 WPST modify/repair/re-install removes HASP drivers 

On Windows XP, if the WPST software is re-installed over itself, the HASP key drivers 
are deleted from the system. Requires that WPST be removed first via the control panel. 
This problem does not occur on Windows 2000. Other observation on both O/S's, the 
install shield modify/repair/remove options output the error message "Could not find 
INSTALL.LOG file." 

1994 Transfer function corrupts MIN1 and MIN2 
Use the WPST transfer screen to copy Settings, PRL, and ERI values from one module 
to another. Used COM1 setting for both ports. MIN1 and MIN2 values were incorrect in 
both NAMs following a subsequent read of the target module. 

1990 Incorrect ACCOLC and MDN values 
The values for the NAM1 ACCOLC and Directory Number fields are incorrectly saved 
to the nvm file. 

1986 Memory leaks 
WPST leaks memory when reading and/or writing from a module or file. 

1983 Too many Level 4 warnings 
There are 165 level 4 warnings when building the WPST application. This is 
unsatisfactory for a commercial product. 

1917 Default NV parameters 
Improper saving of default SMS NV parameters. 

1915 NZT Module Reset Failure 
Observed indications when using WPST to investigate this issue. The module is 
powered on and detected by WPST. An initial read of the module NV items is not 
performed. WPST is used to write 0000 to the Lock Code NV item. The starter kit 
LED1 indicator goes out and then re-illuminates following the completion of the 
module reset. The module is functional for other operations. WPST is then used to write 
the 'ENGLISH' selection to the MO SMS Language NV item. The starter kit LED1 
indicator goes out and never re-illuminates. The module requires a reset of power cycle 
to re-establish communication. 

1829 Release notes file should be SWReleaseNote.pdf instead of Readme 
Embed the release notes file using the file SWReleaseNoteWPST.pdf instead of 
Readme.txt. This will help to ensure WPST release note consistency. 

1827 Automate the installation and cleanup of older WPST versions and CDMA server 
1619 Read/write scheme is incorrect 

The read / write scheme is incorrect. A read from the module or file should invalidate 
any values displayed and update the display with the new values. Uses cases need to be 
determined for module and file write operations. 

1615 Temporary files are unnecessary 
The temporary files created at application initialization are unnecessary. The file 
extensions should be registered via the document template. 

1614 File open and save dialogs should default to the last used folder 
1607 No view creation error handling 
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Id Description 

WPSTView::OnUpdate function deletes the active view before creating the new view. 
There is no mechanism for handling a creation failure. There is a lot of redundant code 
in this function. 

1448 Application frame title update is slow 
The update of the application's frame title is slow as the operation is performed during 
idle processing - CWPSTApp::OnIdle. 

1298 The first ERI file is not written in a multiple write operation 
When writing multiple ERI files, the first ERI file is not committed to nv. The second 
file appears as expected. 

1257 The ability to read and write PRL’s is needed 
The WPST should allow the user to: 1) read a PRL from the module and write it to a 
file. 2) read a PRL from a file and write it to a module. The application currently hard 
codes the read file names to the current directory\\tempPRL1.prl. This should be a user 
selected item. 

1190 NV File Header application and file version hard coded 
During a save to file operation, the header values written to the nv file for the 
application and file versions are hard coded. The ESN field and creation date values are 
empty strings and should be utilized. 

1188 WPST - Upgrade License Agreement 
WPST only displays the license agreement screen on a new install. The screen should 
also be displayed on an upgrade to a different version to ensure any changes to the 
license are agreed to by the user. The screen can probably be suppressed if reinstalling 
the same version. 

1023 WPST - Download of Code 
If an unsuccessful software download occurs, it is not possible to re-download to the 
module. Using the WPST File -> New menu item, the WismoQuick device is selected. 
The .hex file for the module is then selected. When the FLASH button is clicked, the 
prompt is presented for the SPC code. After the SPC code is entered, no download is 
performed. 

 

4.2 CDMA Server Corrections 
Id Description 

2024 Irrelevant error messages 
Use a module with a Fujitsu flash and J’tagged only with the boot loader. Use WPST to 
download WZ2.10G to the module. This results in a download failure and the error 
message “Fujitsu Flash not supported for 2.10G” being reported. 

2014 Update nvitemtypes.h file 
CDMAServer nvitemtypes.h is out of sync with nv.h. Two new nv items and item types 
were added in nv.h revision 1.4 

2013 Add download support for Q2438 V6 
Add support for Spansion S71WS064JB0 and S71PL064JA0 flash parts. 

1965 Add support for 4800 bps baud rate. 
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Id Description 

1930 CDMA Server - Update to DP3420 merge nv.h 
Update the CDMA Server application to include the nv.h file used in the DP3420 merge. 
This provides compatibility with the WZ3.00 releases. 

1703 CDMA Server 2.19 download error: 

Module with preprogrammed Toshiba flash image (2.10G). An attempt to download the 
WZ2.10G release may result in an error. 

1684 The NV list in current download Tools does not match NV list in WZ2.10G software 
release. 

1478 ERI files need to be retrieved / restored during a download operation. 
1384 Module does not respond to AT$QCDMG: 

The CDMA Server is often unable to detect WZ2.01 and later modules on UART1 
especially when data related NV items have been modified. The module does not 
acknowledge the AT$QCDMG command when sent and never switches to DM mode. 

An application note will be created to inform users of the risk associated with the auto 
packet detection item. 

1032 Update CFlashDownload class 
357 CDMA Server NV Retrieve/Restore does not support multiple NAM’s. 

 
 
 

5 Known Issues 
This section identifies the known issues in this release. 

5.1 WPST Known Issues 
Id Description 

2048 Transfer Dialog does not work as intended 
2000 Incorrect  data read from legacy nvm file 

If an older nvm file is read by WPST, the NV_WV_SMS_SETTINGS_I formatting will 
be overwritten and the packet format will be incorrect. WPST should always populate the 
nv_wvsms_settings_type structure with defaults on file reads for the non-modifiable 
parameters to protect against incorrect legacy files. 

1907 WPST 1.2.0.1 install issues on Win2000, SP4 
Tried to install 1.2.0.1 over 1.1.0.2 on Windows 2000 Professional SP4, but it wouldn't 
because early in the Install Shield, it complained of a lack of H:.  Tried it on a XP Home 
SP2, and it worked fine. 

1821 TAB key does not move cursor to next IP field: 

Once three digits are entered into a sub-field of the IP address, the input cursor should 
auto-advance to the next sub-field. Tab and period keys should also advance the input 
cursor to the next sub-field. Currently, a mouse click or arrow key is required to fill each 
sub-field of the IP address. 
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Id Description 

1797 SID value verification: 

A value greater than 32768 can be entered into a SID field. No warning is presented to the 
user. If a write to module is performed, the incorrect value is not written and a subsequent 
read will show the original NV value. 

1001 Document Overridden Fields: 

A number of field values are overridden by the release software in the module. These 
fields should be described in the WPST documentation and include the value that is set. 
Some of these fields are: Lock Code, Channel Numbers, VoCoder Gain, and MDR 
Settings. 

981 White space prevents SID/NID value entry in NAM: 

When entering values for the SID/NID fields in the NAM, sometimes it is not possible to 
enter a complete value. Once all white space characters are highlighted and deleted, an 
entry can be made. Data entry should overwrite white space for these entries. 

642 A user's guide is needed for the WPST application. The user's guide should detail the 
program functionality and features. 

395 Phonebook feature is not supported 

 

5.2 CDMA Server Known Issues 
Id Description 

1308 Corrupt hex file can cause an unhandled exception: 

A lack of error checking in the CFlashDownload class allows a corrupt hex file to cause 
an unhandled exception. 

869 The phonebook is not restored during a module software upgrade: 

During the software upgrade process, the entire phonebook is not restored - only index 
zero. 

495 CDMA Server needs an expanded GetDeviceInfo method 
In order to pass additional device information available in CS1.06 CDMA Server 
versions, an expanded GetDeviceInfo method and structure need to be implemented. The 
structure should add the port state, baud rate, and 2 place holders for future expansion. 

494 CDMA Server needs to return downloader error codes 
CDMA Server needs to return downloader error codes as defined in DWLWin return 
codes version 1.0. 

368 CDMA Server fails unpredictably if stopped during download: 

If applications try to stop a download that is in progress, the CDMA Server fails 
unpredictably. Partially fixed. Additional work needs to be done to allow the server to be 
more responsive to shut down requests while downloading 
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6 Glossary 
 
Acronym Definition 
AT Attention – DTE DCE command set originated by Hayes (see TIA-707) 
AVS Audio/vocoding/sound 
BSP Board support package 
BTS Base station transceiver subsystem 
CDMA Code division multiple access 
CP Call processing 
CRC Cyclic redundancy check 
DIAG Diagnostic Services subsystem – responds to the Diagnostic Monitor (DM) 

and QPST;may also be used to refer to a diagnostic task 
Dload Download Services – handles the asynchronous download protocol using 

the UART to retrieve new software into the phone; also used for the 
software upgrade of the internal phone Flash ROM 

DM Diagnostic monitor 
DMSS Dual-mode subscriber station – refers to QUALCOMM CDMA software 
DTMF Dual-tone multifrequency 
E911 Emergency call system (in the United States) 
EVRC Enhanced variable rate coder 
GPIO General-purpose input/output 
GPRS General packet radio system 
GPS Global Positioning System 
GSM Global system for mobile communication 
ID Identifier 
IMSI International mobile station ID 
JTAG ICD Joint Test Action Group In-Circuit Debugger 
MCC Mobile country code 
MDM Mobile diagnostic monitor 
ME Mobile equipment 
MMI Man-machine interface 
MS Mobile station, also referred to as the mobile 
MSC Mobile services switching center 
MSID Mobile station identifier 
MSM Mobile station modem – one of the types of ASICs produced by 

QUALCOMM CDMA Technologies 
MT Mobile-terminated 
MUI Mobile user identifier 
NAM Number assignment module 
NID Network identification number 
NV Nonvolatile 
OS Operating system 
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Acronym Definition 
OTA Over-the-air 
OTAPA Over-the-air parameter administration 
OTASP Over-the-air service programming 
PCS Personal communications services 
PDU Protocol data unit 
PN Pseudorandom noise 
PRL Preferred roaming list 
PST Product support tool 
PSTN Public-switching telephone network 
QCELP QUALCOMM codebook excited linear prediction 
QXDM QUALCOMM extensible diagnostic monitor 
REX Real-time executive kernel – preemptive, multitasking real-time operating 

system that provides APIs for task control, task synchronization, mutual 
exclusion, timers, and interrupt control 

RF Radio frequency 
RL Roaming list or radio link, depending upon the context 
RSSI Receive signal strength indicator 
RT Real-time 
RTOS Real-time operating system 
RTT Radio Transmission Technology 
R-UIM Removable user identity module – similar to the SIM card concept in the 

GSM standard 
SAT Supervisory audio tone 
SCI Slot cycle index 
SER Symbol error rate 
SID System identification number 
SMS Short Message Services 
SPC Service programming code 
SURF Subscriber unit reference platform 
TMSI Temporary mobile station identifier 
Tone An identifier that directs the Sound Server to play a predefined pair of 

frequencies for a specific duration. 
Trimode Ability to operate in 1900 MHz CDMA, 800 MHz CDMA, and 800 MHz 

analog in one MSM build 
UART  Universal asynchronous receiver transmitter 
UI User interface 
UMTS Universal Mobile Telecommunications System 
USB Universal serial bus 
VBR Variable bit rate 
WAP Wireless application protocol 
WCDMA Wideband code division multiple access 
WPST Wavecom Product Support Tool 
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